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Chapter 1: Getting Started

In this chapter:

• About this Guide

• What is WorkSpace?

• What is WorkSpace Connect?

• Installing WorkSpace

• Installing WorkSpace Connect

• Opening WorkSpace

• Opening WorkSpace Connect

• Checking for Software Updates

• How WorkSpace Works

• Customizing WorkSpace Preferences

About this Guide
This WorkSpace Getting Started Guide provides instructions for getting 
up and running quickly with WorkSpace. For further information, 
please see the online help that is installed with the software, or visit 
www.einstruction.com for online training videos.

What is WorkSpace?
WorkSpace is a next-generation teaching program for the digital 
classroom. WorkSpace creates a virtual interactive whiteboard, by 
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allowing you to create an interactive lesson out of anything you can 
run on your computer desktop.

Sample WorkSpace presentation

Used in concert with Exam View Assessment Suite, Touch Board, 
DualBoard, Mobi View and Mobi Learner tablets, or with one of our 
Student Response Systems, such as CPS, WorkSpace gives you the 
means to interact with any form of digital content and really connect 
with your students.

WorkSpace enables interaction with lesson materials from virtually any 
source, including publishers’ content from more than 9,000 textbook 
titles. But that's just the beginning. Add to that, more than 50 tools for 
creating, displaying, annotating, organizing, controlling, importing, 
capturing, recording and sharing teaching materials. Perhaps most 
importantly, WorkSpace can be used with any program, content, or 
curriculum. With WorkSpace, you can engage and immerse your 
students in a way you never thought possible. Best of all, it's EASY to 
learn and use.

WorkSpace Features

WorkSpace contains many useful features enabling you to create a 
truly interactive and engaging learning experience for your students.

Just a few of the special features to explore include:

• Opening a file or website using the Mouse tool.

• Creating concepts or math problems using the Shapes and Lines 
tools.
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• Graphing with Grid pages.

• Selecting any image on your screen to incorporate into a lesson 
with the Capture tool.

• Selecting from pre-created lesson materials and images to 
enhance a lesson using the Gallery tool

Capture a 
picture from a 
website

Incorporate 
pre-created 
content in the 
Gallery

.

Sample WorkSpace lesson page utilizing the Capture and Gallery tools

What is WorkSpace Connect?
WorkSpace Tablet Application turns your tablet into a WorkSpace 
compatible mobile interactive whiteboard. 

Installing WorkSpace
WorkSpace is compatible with Windows, Mac and Linux operating 
systems. To install WorkSpace, simply install the WorkSpace software 
and connect your computer to a projector.

Note: You must have administrator privileges on your computer to install the 
software.
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Installing WorkSpace Connect
WorkSpace Tablet Application is compatible with Android tablets and  
iPads. After installing WorkSpace go to your application store to 
download the WorkSpace Tablet Application.

Opening WorkSpace
After installing WorkSpace, you’ll notice the eInstruction icon 
on your desktop. Simply double-click this icon to open 
WorkSpace.

Opening WorkSpace Connect
Before opening the tablet application we will need to enable tablet 
use. Go to WorkSpace> Preferences> Tablet Settings.

Here you will enable or disable tablet use with WorkSpace. Under 
Enable/Disable, check the box Allow Tablet.

Enter your computer name (if not auto completed) and a password for 
your tablet device.

Remember to click Save/Update before exiting the window. 

The application will now show the computer as an available device. 
On your tablet, click on the WorkSpace icon to open.
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Checking for Software Updates
Before using WorkSpace for the first time, check for software updates.

To check for software updates

• Select Help > Check for Updates from the main WorkSpace 
menu.

WorkSpace menu

How WorkSpace Works
WorkSpace allows you to capture text, graphics, or virtually any image 
from any application that you can run and project from your computer.

WorkSpace has four different modes:

• Mouse mode: Run applications and access the Internet 
using the Mouse tool. 

• Lesson mode: By default, WorkSpace opens in Lesson 
mode. You can also select any of the annotation tools while 
in Mouse mode to return to Lesson mode.

In Lesson mode, WorkSpace takes a screenshot of your desktop 
and allows you to annotate over that static image. Write, draw, 
insert images, highlight, interact with and annotate over prepared 
material. You can also use a blank page as a whiteboard at any 
point in your lesson without leaving the WorkSpace presentation.

• Annotate over desktop mode (Windows only): Annotate 
over moving images such as video, animation, or website 
with flash applications with all of the same tools that are 
available during Lesson mode.
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• Office mode (Windows only): Open and interact with 
Microsoft Office applications directly from the WorkSpace 
software.

Mouse and Lesson mode are the most frequently used modes.

Note: Lesson mode, Annotate Over Desktop mode and Office mode icons can 
be made available by customizing the WorkSpace toolbar. Please see page 8 
for information on customizing the toolbar.

WorkSpace saves all of your annotated pages for each session as a 
presentation file.

Note: Presentation files are automatically saved with the current date and 
lesson number as the file name (e.g., 15 August 2012_1.GWB).
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The WorkSpace Window

By default, WorkSpace opens in Lesson mode. You’ll notice the main 
WorkSpace floating toolbar on your desktop. The toolbar allows you 
to:

• Quickly access frequently used tools.

• Select from all available WorkSpace tools. 

• Customise preferences, such as tools on the main toolbar, default 
page backgrounds, screen capture settings and the default folder 
for saving presentation files. 

• Select the main WorkSpace menu to access online help, file 
distribution options, editing options and to exit WorkSpace. 

WorkSpace window - Main toolbar
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Minimise Toolbar 

Mouse Mode 

Selector 

Highlighter

Shape tool

Text Tool

Revert 

Blank Page

Gallery 

Previous page 

Save

Student Response 
System 

WorkSpace Menu

Lesson Mode

Pen Tool

Eraser

Line Tool

Equation

Clear

Grid Page
 

Next page

Sort Pages

Toolbox

Exit

To move the toolbar:

• Position the cursor at the 
top of the toolbar near the 
WorkSpace icon and then 
click and drag to the 
desired location.

To resize the toolbar:

• Position the cursor at the 
edge of the toolbar until a 
double-headed arrow 
appears and then click 
and drag to resize. 

“Basic” WorkSpace toolbar for Windows (can be customized)

Note: The WorkSpace toolbar settings can be customized. Select 
Preferences > Customise Toolbar from the main WorkSpace menu 
to customise preferences. See Chapter 3: WorkSpace Tools At-a-
Glance for a complete list of available tools. 

Tip! The WorkSpace toolbar will become transparent if not in use. Simply click 
on the toolbar to reactivate it.
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Upon selecting any of the annotation tools, you’ll notice several toolbars along 
the bottom of your screen. 

Properties Bar
Page Function Toolbar 

Toolbar

Layers Toolbar

The WorkSpace window

The WorkSpace Properties bar provides options to change the 
properties of the selected annotation tool (pen, highlighter, shape). For 
example, the Pen tool Properties bar includes color, width, 
transparency, line ends and line styles. 

Preview PaneLine Colour Line 
Width

Line 
Ends

Line
Style

Transparency

Properties bar

To the right of the properties bar, is the Page Functions toolbar. 
Navigate between pages and access shortcut menus for the current 
mode, such as inserting a question, or setting up multiple users.

Page
Count

Previous
Page

Next
Page

Insert Question (Shown)

Multi-User Setup
 (Lesson mode)

Pan 
Page

and Page
Selector

OR

Page Functions toolbar
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To the left of the Properties toolbar is the Layers toolbar. The Layers 
window appears when using the toolbar. By default, all annotations on 
a page are arranged in a single layer. Add, delete, show, hide and 
arrange different layers. 

Add Delete
LayerLayer

Edit 
Layer

Maximise
Layer

Layers Toolbar Layers Window

Previous
Next

Show
Hide

Toolbar

Layers toolbar and Layers window

Customizing WorkSpace Preferences
WorkSpace is ready-to-use right out of the box. However, you can 
customise WorkSpace using the Preferences screen. 

Preferences window (Windows)

To customise preferences

• Select Preferences from the main WorkSpace menu.



Preferences include:

• Options - Designate the default folder where a WorkSpace 
presentation file is saved and set various options such as cursor 
orientation, auto-save preferences and window sizing.

• New Page Setup - Set the default background color and size for 
the Blank and Grid page tools, set screen capture preferences, 
such as window, partial, or screen (default) and set annotate over 
desktop preferences (Windows only).

• Transparency and Language - Set the background color of an 
image to be transparent, select the desired language.

• Toolbar Settings - Set the shape and size of the toolbar icons.

• Customise Toolbar - Select your most frequently used tools to 
appear on the main toolbar.

• Gradient Page Setup (Windows Only) - Select the desired 
background for a gradient page.
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Chapter 2: Using WorkSpace

In this chapter:

• Annotating Content

• Creating a Presentation

• Use pre-created presentations created for WorkSpace. To find 
online presentations, aligned with state standards, visit 
www.einstruction.com and download the latest WorkSpace 
Content file. Or visit the eI Community™ at 
www.eICommunity.com and access more than 125,000 
instructional resources, organised and searchable by subject, 
grade level, media type and standards. 

Annotating Content
Open an existing presentation, file, blank page, or website and 
annotate it.

To annotate a projected image

• Select any of the annotation tools to begin annotating the image 
on your screen.

Tip! To open a desired file or website, use the Mouse tool.
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Notice the WorkSpace Properties bar appears while in Lesson or 
Annotate over desktop mode. During Mouse mode, this bar 
disappears, allowing full access to your desktop.

WorkSpace toolbar

Previous and 
Next arrows

To switch between Lesson mode and Mouse mode, select the 
appropriate tool (Mouse or any of the annotation tools). On the Page 
Functions toolbar, use the Previous and Next arrows to page through 
a WorkSpace presentation. These arrows are also available on the 
WorkSpace toolbar.

Creating a Presentation
WorkSpace automatically saves all pages created during a single 
session as a presentation. Presentation files allow you to easily 
manage and share lesson plans with students, parents and other 
teachers.

Adding Pages to a Presentation 

Automatically add pages to a presentation file. Each time you annotate 
a new desktop image or create a blank page, a new page is added to 
the current file. 
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Editing a Presentation 

Easily edit, review, move, copy, merge and delete pages in a 
presentation file using the Page Sorter function.

To edit a presentation

From the WorkSpace toolbar, select Page Sorter.

Distributing Files

You can export and distribute files in a number of formats, including 
JPG and HTML. The easiest way to distribute files is to save as a PDF 
file.

To distribute files

From the WorkSpace toolbar, select Toolbox and then Export 
PDF File.

or

From the WorkSpace menu, select Export PDF File, or 
one of the other available file export options.

Save or Save as: GWB - Content can be saved 
using the WorkSpace native file format (GWB). The 
GWB file format stores all information and formatting 
without loss of data. The advantage of saving in a GWB file format is 
that you can easily open and edit the content with ease as many times 
as needed. 

Save or Save as: IWB- Content can be saved as a Common File 
Format (IWB). Saving in common file format allows you to share your 
content with any interactive whiteboard and software if the board and 
software accepts the CFF formatting. Some formatting and interactivity 
of content may be lost, due to the ability to exchange information 
between the two softwares. 
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Auto Save: By default, the Auto save feature automatically saves the 
presentation file every five minutes. You can disable Auto save or 
change the frequency of auto saving in Preferences > Options.

E-mail: Content can be e-mailed as a WorkSpace native file format 
(GWB). Choose to e-mail as a GWB or a PDF. 

Export as: Content can be exported into several convenient options 
such as; PPT, BMP, JPG, GIF, TIFF, PNG, PDF, HTML(.png), HTML(.jpg). 
The exported file is saved in the My Documents (or Documents)/
Interwrite WorkSpace/Export folder.

Export as PDF: Export the currently open presentation file to a PDF 
format. By default, the PDF file is saved in the My Documents (or 
Documents)/Interwrite WorkSpace/Export folder.

E-mail as PDF: Content can be e-mailed as a PDF. Content is first 
saved as a GWB file. The GWB file is converted and attached to a new 
e-mail, if there is an e-mail client installed. 

Print: Content can be printed from the menu bar. File> Print.
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Using a Pre-Created Presentation Plan 

Use pre-created presentations created for WorkSpace. To find online 
presentations, aligned with state standards, visit www.einstruction.com 
and download the latest WorkSpace Content file. Or visit the eI 
Community™ at www.eICommunity.com and access more than 
125,000 instructional resources, organised and searchable by subject, 
grade level, media type and standards.

If using WorkSpace with DualBoard or Mobi tablets, more than one 
person can write on the interactive or virtual whiteboard at one time. 

The types of devices connected to WorkSpace determine how many 
people can work on the whiteboard simultaneously. Up to nine devices 
may be used, but only two of those devices may be pens used with 
DualBoard.

Note: The pens used with Mobi and DualBoards are the same style pens.

Selecting Multi-User Mode

Selecting the Multi-User icon  in WorkSpace will display the 
available options depending on the types and quantity of devices that 
Device Manager has detected.

To begin Multi-User mode:

1. Open the Device Manager utility and select all devices to be used.
Tip! Select the eInstruction icon from the system tray to access the Device 
Manager menu.

2. Create a blank page.

3. Click on the Multi-User icon in the Properties bar and then select 
Multi-User Page Setup from the pop-up menu.

Multi-User
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4. Select the desired page layout.
The available devices (DualBoard Pens, Mobi units, WorkSpace Tablet) 
will appear in this screen. After selecting the layout, drag the device to 
a panel to assign it to that area.
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Selecting the Presenter

The “presenter” in multi-user mode controls when multi-user mode 
begins and ends. 

To select the presenter

1. Open the Device Manager utility.

2. Select the icon for the desired presenter device.

3. Select Options > Set Presenter.

Locking Student Tablets and Clickers (If Applicable)

If using student tablets or clickers with WorkSpace, the presenter can 
lock any devices in use and regain control of the session.

To lock student tablets

1. Open the Device Manager utility.

2. Select the icon for the desired device to be locked.

3. Select the Lock icon. Select the Unlock icon to unlock the 
tablets.

Tip! You can also lock all devices by selecting the Lock icon from the 
master toolbox on the toolbar.
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Using the Gallery
The WorkSpace Gallery tool provides thousands of pre-created 
resources to supplement your lesson planning. The Gallery stores 
images, background pages, teaching tools and interactive flash 
simulations (Windows) or Interwrite Sims (Mac).

Before using the Gallery for the first time, WorkSpace will prompt you 
to build the Gallery, which is installed with WorkSpace. After the 
Gallery is built you are ready to go!

WorkSpace Gallery

Upon opening the Gallery, you will see three main tabs:

• Content - Select from pre-installed categories, such as Math and 
Geography

• Favourites - Add your own media to the Gallery

• Advanced Search - Search for gallery items by keyword 
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Selecting Gallery Objects

To select a Gallery object

1. Select the Content tab.

2. Click the plus sign next to a category to expand that category.

3. Scroll through and select your desired object.

Adding Files to the Gallery

Add and organise new files to the Gallery through the File menu.
The File menu allows you to build and organise your Gallery files by 
creating new folders, importing images and even accessing the eI 
Community, a free online community available through 
www.einstruction.com with thousands of pre-created Gallery teaching 
materials.

To add files to the Gallery

1. Select the File menu.

2. Select Add Files to Gallery.
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 Chapter 3: WorkSpace Tools At-a-Glance

This chapter provides a quick reference guide to the available tools in 
WorkSpace. Some of the tools, such as those in Office mode, are not 
applicable in the Mac version of WorkSpace. These differences are 
noted where applicable.

Basic Toolbar

Minimise Toolbar 

Mouse Mode 

Pen tool

Eraser

Line tool

Text

Revert 

Blank Page

Sort Pages 

Previous Page 

Save

Student Response 
System

WorkSpace Menu

Select Object

Highlighter

Shape

Type Text

Equation

Clear

Grid

Next page

Sort Pages

Student Response 
System
Exit (Win)/
Quit (Mac)

Basic toolbar
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Tool Definitions
The following tables define the purpose and functionality of each tool 
in more detail. Don’t forget to view the Properties bar for a selected 
tool, to explore and change available tool properties.

• Table 1“,WorkSpace Modes”, on page 22.

• Table 2“,Tools Available in Lesson and Annotate Over Desktop 
Mode”, on page 23.

•

Table 1: WorkSpace Modes

Icon Mode Use Win Mac/
Linux

Mouse Run applications or access 
the internet with the pen.

X X

Lesson Create and annotate 
lessons, presentations, 
blank pages, or images. 

X X

Annotate Over 
Desktop Mode

Annotate over moving 
images such as videos, flash 
applications or animations 
without pausing or freezing 
the images. 

X

Office Mode Launch the Office Mode 
toolbar, giving you the 
ability to access and create 
documents using the 
Microsoft Office suite of 
products.

X

Table 3“,Tools Available in Office Mode”, on page 32.
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Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux

Pen Write or draw. X X

Multicolour 
pen

Draw colourful lines. The 
Multicolour Pen has two different 
styles, Gradient and colour on 
colour.

• Gradient: The properties to 
the left of the Gradient Style 
button define the starting 
colour, while the properties 
to the right define the 
ending colour.

• colour on colour: The 
properties to the left of the 
Gradient Style button define 
the outside, border colour, 
while the properties to the 
right define the inside 
colour.

X X

Picture Pen Draw a path of images. The 
selected picture is displayed on 
the left side of the properties bar. 
Click on it to access a menu.

X

Line Draw lines. X X

Freehand 
Text

Convert any alphanumeric 
characters written with this tool 
into typed text. 

X X

Freehand 
Shape

Convert an object drawn 
freehand, such as a rectangle, 
into a true rectangle with 90 
degree corners and straight 
perimeter lines. 

X
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Highlighter Highlight anything on the current 
page. 

X X

Shapes Draw different shapes. X X

Flash Player

(Interwrite 
Sims for 
Mac)

Add SWF files to your 
presentation. 

1. Click on the tool and select 
an SWF flash file from the 
directory. 

2. Click on the green arrow to 
activate the flash file. 

3. Use the Selection tool to 
move, resize, or delete the 
flash file. 

Note: Only two (2) flash files are 
allowed per page.

X X

Type Text Add typed text.

1. Select the Text tool from the 
Toolbar.
Change font properties 
before you begin typing. 

2. Click where you want the 
Text window to display and 
begin typing.

3. When you have finished 
typing, select the Selection 
tool. The Text window closes 
and the text is placed on the 
page.

X X

Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux
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Stamper Add stamps. Personalise the 
Stamper by adding your images 
to the My Documents/Interwrite 
WorkSpace/User Stamps folder. 
The images must be in a BMP, 
GIF, JPEG, TIFF, or PNG format. 
If you add new stamp images to 
the User Stamps folder while 
WorkSpace is running, the 
stamps will not be available for 
use until you exit WorkSpace and 
re-open it.

X X

Audio File 

(Audio Note 
for Mac)

Not 
available on 
Linux

Add audio files to your 
presentation files. The following 
audio file formats are supported: 
WAV, MP2, MP3, MPA, MPEG, 
SND and WMA, as well as audio 
files made with the Record and 
Playback tool and those 
downloaded from other sources 
(e.g., iTunes).

(not available in Annotate over 
Desktop mode)

X X

Video File Add video files to your 
presentation. The following file 
types are supported: AVI, WMV, 
MOV and MPG.

(not available in Annotate over 
Desktop mode)

X

Pan Page Move the page around in the 
Annotation window.

X X

Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux
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Selection Select objects. Selected objects 
can be sized, moved, cut, 
copied, pasted, deleted, 
reordered, rotated, grouped, 
ungrouped, moved to the 
background, exported and 
added to My Gallery. 

X X

Eraser Erase objects. X X

Zoom Magnify the page.

(not available in Annotate over 
Desktop mode)

X

Create 
Blank Page

Add a blank page to the 
presentation file. 

X X

Create 
Duplicate 
Page

Add a duplicate of the current 
page to the presentation file, 
directly after the current page.

(not available in Annotate over 
Desktop mode)

X X

Create 
Calendar 
Page

Add calendar page to the 
presentation file. Select and 
preview a one-week, one-, two-, 
three-, or four-month calendar. 
Indicate a starting Month and 
Year (the current month and year 
is the default) and choose a 
Background colour for the 
calendar. 

X X

Create Grid 
Page

Add a grid page. X X

Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux
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Create 
Image Page

Add an image page. X X

Gallery Open the Gallery. The Gallery 
contains an extensive collection 
of images and interactive Flash 
simulations, called Interwrite 
Sims, arranged in categories for 
your convenience.  

X X

Spotlight

Not 
available on 
Linux

Create interest and draw 
attention to an area of the 
screen. A spotlight circle appears 
in the centre of a black curtain. 
The spotlight opening is 
transparent and reveals what is 
directly beneath it on the screen. 
Click and drag the Move cursor 
to move the spotlight around the 
screen. 

X X

Page Sorter View thumbnails of the pages in 
a presentation file. Select a page 
by clicking on it. Click and drag 
a page to a different location in 
the presentation file. 

(not available in Annotate over 
Desktop mode)

X X

Previous 
Page

Go to the previous page in the 
presentation file. 

X X

Next Page Go to the next page in the 
presentation file. 

X X

Clear Delete the selected object or 
objects. If nothing is selected on 
the page, the Clear tool deletes 
everything on the page.

X X

Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux
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Import from 
Device

Obtain images, documents, or 
other files from a device such as 
a scanner or a digital camera 
and insert them into WorkSpace.

X X

Save Save the current presentation 
file. By default, the Autosave 
feature automatically saves the 
presentation file every five 
minutes. Disable Autosave or 
change the frequency of 
autosaving in the Preferences 
window.

X X

Onscreen 
Keyboard

Place your cursor where you wish 
to insert typed keyboard 
characters.

X X

Lock Pads Lock all connected devices 
(clickers or tablets), preventing 
them from providing input to the 
current session. Locked devices 
remain connected unless they 
are turned off. Click the Unlock 
icon that appears in its place to 
reactivate connected devices.

X

Internet 
Browser

Open an Internet browser to the 
webpage indicated in the 
Preferences window. 

X

Page Up Go to the previous page in a 
PowerPoint slide show, while 
saving the annotated page in the 
Annotation window to the 
presentation file. Even though 
the tool was specifically designed 
to work with PowerPoint, it will 
work with any application that is 
directly under WorkSpace and 
uses a Page Up command.

X

Table 2: Tools Available in Lesson and 
Annotate Over Desktop Mode

Icon Name Use Win Mac/
Linux
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Page Down Go to the next page in a 
PowerPoint slide show, while 
saving the annotated page in the 
Annotation window to the 
presentation file. Even though 
the tool was specifically designed 
to work with PowerPoint, it will 
work with any application that is 
directly under WorkSpace and 
uses a Page Down command.

X

Curtain

Not 
available on 
Linux

Hide the current page, or hide 
the current desktop screen, if you 
are in Mouse mode.

X X

Insert Media Insert any type of media file, 
including BMP, JPEG, GIF, EMF, 
WMF, TIFF PNG, ICO, audio 
files, video files and Flash files. 

X X

Capture Capture a snapshot of either the 
full screen, a selected window, or 
a selected portion of the screen. 

X X

Undo Undo the most recently 
performed operation. 

X X

Redo Redo the last Undo operation. X X

Preferences Open the Preferences window to 
configure settings for many of 
the WorkSpace tools and 
functions.

X X

Table 2: Tools Available in Lesson and 
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Freehand 
Text 
Recognition

Convert handwritten text into 
typed text and insert the typed 
text into an active application, 
such as Word, or Excel. The 
Freehand Text Recognition 
window provides a spelling 
checker and the ability to insert 
Carriage Return, Space, Tab and 
Backspace characters into the 
text.

X X

Freehand 
Equation 
Pen

Convert any numeric characters 
written with this tool into typed 
text. 

X X

Equation Add typed Equations.

1. Select the Equation tool 
from the Toolbar.
Click where you want the 
Equation window to display 
and begin typing.

2. When you have finished 
typing, select Insert 
Equation. The Equation 
window closes and the 
equation is placed on the 
page.

X X

Record and 
Playback

Record and play back events, 
with sound, as they occur. Events 
are stored in an AVI file for 
playback.

X X

Export PDF 
File

Export the current presentation 
file to a PDF format. By default, 
the PDF file is saved in the My 
Documents/Interwrite 
WorkSpace/Export folder.

X X

Table 2: Tools Available in Lesson and 
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Email PDF 
File

Export the current presentation 
file to a PDF format and 
automatically attach it to an 
email message.

X X

Timer Time classroom activities, exams, 
or quizzes.

X X

Student 
Response 
System

(Start PRS 
on Mac)

Click the icon to display the 
question menu, if using an 
eInstruction Student Response 
System.

X X

ExamView Launch Exam View. X X

Ruler Demonstrate how to use 
measurement between two 
points.

X

Triangle Demonstrate triangle 
measurements. 

X

Protractor Demonstrate angle 
measurements.

X

Compass Demonstrate circles and arcs, 
and measure distances.

X

Link History

(Insert 
Hyperlink 
on Mac)

Follow your link history for the 
current session. This tool is 
available only when a 
presentation file is open and a 
GWB link has been clicked.

X X

New Page 
Setup

Set the page options for a new 
page. 

X X

Table 2: Tools Available in Lesson and 
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Fill Tool Fill any object with colour or 
change the background of the 
page if no object is selected.

X X

Gradient 
Page

Add a gradient page. X X

Exit
(Quit in 
Mac)

Exit WorkSpace. X X

Toolbox Display all available WorkSpace 
tools. Customise the 
organisation of the tools on this 
menu and on the Toolbar in the 
Preferences window.

X X

Device 
Manager

Open the Device Manager 
application.

X X

Minimise 
Toolbar

Minimise the Toolbar, or restore 
the full-size Toolbar.

X X

WorkSpace 
Menu

Open the WorkSpace menus. X X

Table 3: Tools Available in Office Mode

Icon Menu Use 

Start PowerPoint/
Word/Excel

Start the selected Microsoft Office 
application.
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Insert All 
Annotations

Insert all the annotations into the current 
PowerPoint slide, Word page, or Excel 
spreadsheet.

Insert Selected 
Annotations

Insert selected annotations into the 
current PowerPoint slide, Word page, or 
Excel spreadsheet.

Add Blank Slide Add a blank slide to the current 
PowerPoint slide show. It is available only 
when a PowerPoint Slide Show is 
running.

Save as Slide in 
PowerPoint

Save the current annotated screen as a 
slide in the open PowerPoint 
presentation. The slide will be appended 
at the end of the PowerPoint file.

Clear Delete the selected object or objects. If 
nothing is selected on the page, the 
Clear tool deletes everything on the 
page.

Table 3: Tools Available in Office Mode
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eInstruction Office eInstruction APAC-EMEA 

14400 N. 87th St., Ste 250
Scottsdale, AZ 85260
Tel: 480.948.6540
Fax: 940.948.5508

ZI Les Mardelles
26-36 rue Alfred Nobel 

93600 Aulnay-Sous-Bois
France 

  
Tel: +33 (0) 1.58.31.10.70

Fax: +33 (0) 1.58.31.10.69 
Tech Supp: +33 (0)1.58.31.10.65

 
www.einstruction.eu

Technical Support
www.einstruction.com/support

+1 480.443.2214 (U.S.)
+1 888.333.4988 (U.S. Toll free)

+33 (0) 1.58.31.10.69 (EMEA)
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